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The Access 2007 environment ■ Getting started with

Access 2007 ■ Templates ■ Building a database from a
template ■ Building a database from scratch 

Getting In and Out

Microsoft Access 2003 has undergone a complete
makeover. It has a new name, Microsoft Office
Access 2007 to complement its new look and feel.

The most noticeable change is that Ribbons now replace
menus. Under the hood is the power to manage any data
that you can throw at it. 

Before you learn how to harness this power to create
database applications that the pros in IT will envy, take a
moment for a look-see — kick the tires and take Access
2007 for a spin. 

Access 2007 is new, so don’t skip this chapter even if you
currently use a previous version of Microsoft Access; other-
wise you’ll be lost and miss out on many time-saving new
features.

Starting Access 2007
Starting Access 2007 is the same as starting other pro-
grams. Click the Windows Start button, then All Programs,
and find the Microsoft Office entry. Access 2007 is listed
among the other products that comprise Microsoft Office. 

A faster, more efficient way to start the program is to
add the Access 2007 icon to your desktop, so you need only
to double-click the icon to open Access 2007, or place
Access 2007 on the Quick Launch toolbar.
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4 PART I ■ GETTING STARTED

Start from the desktop
Some programs automatically place an icon on the desktop for you when
you install the program, whether or not you want to launch the program
from your desktop. 

To place Access 2007 on your desktop, follow these steps: 

1. Create a shortcut in the Microsoft Office section of the All Programs
window. 

2. Highlight the Microsoft Office Access 2007 entry and right-click the
mouse button.

3. Click the Create Shortcut entry on the pop-up menu, and another
entry of Microsoft Office Access 2007 appears in the Microsoft Office
section. A 2 next to the name indicates that this is a shortcut entry. 

4. Drag and drop it to your desktop.

To remove Access 2007 from your desktop, right-click the icon and
select Delete. Although the icon is gone from the desktop, the entry is
still in the Microsoft Office section of the All Programs window.

Start from the Quick Launch toolbar
The Quick Launch toolbar (see Figure 1.1) is to the right of the Start
button and is a great time-saver when you have multiple programs open
at the same time that obscure the desktop. Simply kick off Access 2007
from the Quick Launch toolbar instead of digging through open screens
to find Access 2007 on your desktop.

To place Access 2007 on the Quick Launch toolbar:

1. Create a shortcut for Access 2007 (see “Start from the desktop”).

2. Drag and drop the shortcut onto the Quick Launch toolbar.

You can remove Access 2007 from the Quick Launch toolbar by right-
clicking the icon on the Quick Launch toolbar and then clicking Delete.

Inside Scoop
Can’t see the Quick Launch toolbar? Right-click the taskbar and then click Quick
Launch from the Toolbars menu item. 

Inside
Scoop
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5CHAPTER 1 ■ GETTING IN AND OUT

Figure 1.1. The Quick Launch toolbar on my taskbar.

The Access 2007 environment
You’ll find a lot of unfamiliar terms and objects in the Access 2007 land-
scape if you’re new to Microsoft Access. If you currently use Microsoft
Access, you notice that the new landscape is much different than previ-
ous versions. 

The first thing you notice is that there are no menus or toolbars.
These items are a thing of the past and are replaced by tabs that contain
many features that use to be found on menus. This is a good thing
because many time-saving features were overlooked, buried beneath lay-
ers of menus. 

The Ribbon
The Ribbon (see Figure 1.2) is the area on top of the program window
where you choose commands. Commands are grouped in a logical way. 

Related commands are grouped into a tab. For example, you’ll find
all commands needed to design a page layout in the Page Layout tab.

Many tabs are hidden until you need them to work on a task. These
are called contextual tabs. So you won’t see the Page Layout command
tab if you are not designing a page layout. 

Figure 1.2. The Ribbon contains tabs that group together related commands.

Active command tab

Related commands

Name of current database Ribbon

Command tabs

Office Access 2007
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6 PART I ■ GETTING STARTED

Galleries
A gallery (see Figure 1.3) is a control that shows what the command
can do and the results of using the command. For example, the
Margin gallery control displays options for standard margins, such as
Normal, Narrow, and Wide. Each option displays measurements for the
top, bottom, right, and left margins and shows a thumbnail image of
the margin. 

Figure 1.3. A gallery control for setting margins.

Quick Access toolbar
Some commands need to be handy. You find these commands on the
Quick Access toolbar (see Figure 1.4) in the upper-left corner of the win-
dow next to the Office Button.

Save, Print, and Undo are the default commands on the Quick Access
toolbar. They appear as small icons. Simply click the icon to use the
command.

Inside Scoop
You might find that the Ribbon takes up too much screen space. You can mini-
mize a Ribbon by double-clicking the name of a tab on the Ribbon. Double-click
the tab name again to maximize the Ribbon. 

Inside
Scoop
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Figure 1.4. The Quick Access toolbar contains the most frequently used commands.

Customizing the Quick Access toolbar
Microsoft’s engineers knew that you and I want to add commands we use
all the time to the Quick Access toolbar, so they gave us a way to do it.
Follow these steps: 

1. Right-click the Quick Access toolbar. 

2. Click Customize Quick Action Toolbar from the pop-up menu. 

3. Select Choose from drop-down list box (see Figure 1.5).

4. Pick the tab containing the command that you want to drop onto
the Quick Access toolbar. 

The Popular commands are displayed by default.
To add a command to the Quick Access toolbar, do the following:

1. Highlight the command in the left column.

2. Click the Add button, and the command pops onto the Quick
Access toolbar.

To remove a command from the Quick Access toolbar, follow these
steps:

1. Highlight the command in the right column.

2. Click the Remove button and the command pops off the Quick
Access toolbar.

3. Click OK to activate your selection.

Office Button

Quick Access toolbar

Inside Scoop
Change the order that commands appear on the Quick Access toolbar by high-
lighting the command in the right column of the Access Options window and
then clicking the up and down position buttons.

Inside
Scoop
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Figure 1.5. The left column contains command that can be added to the Quick Access toolbar.

The Office Button
The Microsoft Office logo (see Figure 1.6) in the upper-left corner of the
window is more than a pretty picture, it is a button. Click it and you’ll
find useful commands to help manage the objects of your database and
set options for Access 2007. 

You use the Office Button to create new objects, open existing
objects, and save current objects. Think of an object as a component of a
database.

Access options are settings that let you customize how Office Access
2007 works. Options include choosing the default folder for your data-
base, default file format for the database, database sort order, personaliz-
ing your copy of Access 2007, and setting the appearance of parts of
Access 2007.

Bright Idea
If the Quick Access toolbar becomes too cluttered with commands, then move
the Quick Access toolbar below the Ribbon. To do this, click the Customize Quick
Access toolbar and select the Show Quick Access Toolbar Below the Ribbon. 
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Figure 1.6. The Office Button displays commands 
that help you manage Office Access 2007.

Getting Started with Access
When Access 2007 starts, you see the Getting Started with Microsoft
Office Access screen first (see Figure 1.7). From here, you can create a
new blank database or open an existing database. The screen is divided
into three panes:

■ The left pane contains categories of templates for creating different
kinds of databases. Click a category to see a list of templates that
appears in the center pane and then click the template you want to
use for your database.

■ The center pane also contains an icon for creating a new blank
database. Click this to create a database from scratch.

■ The right pane lists the most recent databases that you’ve used.
Click the database name to open it. And if you can’t find your
database listed, then click More to display the Open window where
you can pick the database from your disk drive as you do with other
Windows programs. 
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Figure 1.7. The left pane contains template categories. The center pane lists 
templates in the selected category. The right pane lists recently opened databases.

Using templates
Rather than creating a database from scratch, you can use one of several
database templates that come with Office Access 2007 or download oth-
ers from Microsoft Office Online. 

A template is a prebuilt database that you can use to manage data for a
particular type of business operation, such as managing customers and
tracking expenses. It contains all elements of a database that you need —
except the data. 

When you select a template, Access 2007 automatically builds tables,
queries, forms, reports, and other components that you would have to
build yourself. All you need to do is enter data. 

Using a template is the best way to build a database for a business
operation. Even if your business operation isn’t quite the same as the one
that the template designer had in mind, you can easily create, remove, or
modify any part of the database to meet your requirements. 

Watch Out!
You already have a version of the Northwind database installed if you are run-
ning a previous version of Access. It is best to use the Northwind version that
comes with Access 2007, otherwise the older version might have to be con-

verted to be used by Access 2007. Although this is done automatically when you open it,
errors can result. 
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Template Categories
Template Categories lists two subcategories of templates (unless you’ve
added more) available to use in Access 2007. These subcategories are: 

■ Featuring. This subcategory is the default, and it lists the Customer
Service Database and Marketing Projects Database in the center pane. 

■ Local Templates. You can use eight templates for databases common
to most users.

From Microsoft Office Online
The From Microsoft Office Online section of the left pane lists sub-
categories of templates that are available free of charge from Microsoft’s
Web site. Clicking a subcategory takes you to the section of the Microsoft
Web site that has these templates. A list appears on the center pane.

Building a database from a template
You’re probably anxious to put Access 2007 through its paces, so start
building a database from a template. Then I can continue your tour of
Access 2007. Follow these steps:

1. Under the Template Categories in the left pane, select Local
Templates. Several templates for databases that were part of the
installation are displayed in the center pane (see Figure 1.8). 

2. Click the Assets template and then enter a filename for your data-
base (see Figure 1.9). The default filename is Assets followed by a
number.

Inside Scoop
Make sure that you’re connected to the Internet before clicking any of the sub-
categories under From Microsoft Office Online, otherwise Access 2007 won’t be
able to access the Microsoft Web site.

Inside
Scoop

Inside Scoop
Microsoft validates your copy of Microsoft Office when downloading templates. 

Inside
Scoop
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Figure 1.8. The center pane contains several Business templates.

3. Highlight the default filename and enter a new name. 

By default, the database is created in my C:\Documents and
Settings\Owner\My Documents folder. You might have a different
default folder, but this is the one that appears in my copy of
Access 2007. 

4. Click the open folder icon and then enter the name of a different
folder if you want to store your database in a folder other than the
default folder.

Figure 1.9. Name the database.
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5. Click Create and Access 2007 builds the database using the Assets
template. 

When the database is built, you see the Asset List form (see Figure
1.10), ready for you to enter information about your luxury car, your get-
away hideaway on Maui, and your 145-foot yacht. 

Click the Shutter Bar to open the Navigation Pane where you see all
the components of the database, including tables, forms, reports, and
charts. I show you how to use these and how to create your own through-
out this book. For now feel free to double-click these components and
see what happens.

Figure 1.10. The Asset List is displayed once the database is created. 

Return to the Getting Started with Microsoft Office Access screen.
Click the Office Button and then click Close Database (see Figure

1.11) to close the Assets database and return to the Getting Started with
Microsoft Office Access screen.
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Figure 1.11. Close the Assets database. 

Figure 1.12. Press Alt to see shortcut keys that you 
can use to access some of the Access 2007 features. 

Building a database from scratch
Templates give you a leg up when building a database application, but
you may find yourself spending a lot of time trying to locate a template
that fits your needs. In this situation, building a database from scratch
may be the better choice. 

To build a blank database, follow these steps: 

1. Click the Blank Database icon (see Figure 1.13) from the Getting
Started with Microsoft Office Access screen that appears when you
start Access 2007.

Shortcut keys

Bright Idea
Press the Alt key once, and shortcut keys appear (see Figure 1.12). Press the
shortcut key for the feature you want to use.
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Figure 1.13. Create a new blank database.

2. Enter the filename for the database (see Figure 1.14). 

Figure 1.14. Enter a filename that describes the kind 
of information that will be stored in the database.

3. Click the folder icon to select a folder other than the default folder
to store the database. You select the folder the same way as you do
with other Windows applications.

4. Click the Create button to create the database. Access 2007 auto-
matically creates a table for the database and opens, prompting you
to add a new field.

In Chapter 4, you find out how to transform a blank database into a
powerful Access 2007 database application.

Inside Scoop
It is always best to overwrite the default filename with a name that describes
the kind of information that will be stored in the database and change the
default folder to a folder that you create for your database application.

Inside
Scoop

Inside Scoop
Access 2007 creates a default filename using the word Database followed by a
digit. The digit represents the next available number for the database.

Inside
Scoop
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Opening the Northwind 2007 database
Access 2007 has a complete database — including data — called the
Northwind 2007 database that you use to see how a database works. You
can use this database to explore Access 2007.

The Northwind 2007 database is in the form of a database template.
You use this template to create the actual Northwind 2007 database.
Here’s how to use the Northwind 2007 template to create the Northwind
2007 database.

1. Click Local Templates under the Template Categories. The
Northwind 2007 database icon appears in the center pane. 

2. Click the icon and enter a filename for the database. (You also see
this prompt when you create a database from a template.) 

3. Click the Create button.

4. Close the Startup screen. 

5. Click the Shutter Bar to open the Navigation Pane where you can
see categories of objects (Reports, for example) for the database
(see Figure 1.15). 

6. Click the down arrow next to the category name to see the objects.

Working with form views
A form is used to display, enter, or modify information on the screen
much like the screens that you use at your ATM machine or for a data-
base application in your office. 

In the following sections, I detail the three types of views you use
when working with forms. 
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Figure 1.15. Categories of objects for the Northwind 2007 database.
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18 PART I ■ GETTING STARTED

Form view
People who use your Access 2007 database application typically see data
in a form much like an order form you fill out when buying something
online. 

The form seen by users of your Access 2007 database application is
called the Form view. To explore the Form view open the Customer List
form and then do the following:

1. Click the down arrow alongside the Customers & Orders category to
see all the objects in this category.

2. Double-click the Customer List form, and the Customer List form
displays (see Figure 1.16). This is one way the person who uses
the database application sees and interacts with information in the
database.

The Customer List form displays customer information in columns
and rows much like you see in a spreadsheet. Columns are referred to as
fields, and rows are called records. 

The terms fields and records might be new to you and a little confusing.
We use Access 2007 to manage our information. Information is a
collection of data. Data is a fact that has no meaning, such as a person’s
first name. A field (column of a spreadsheet) stores a piece of data — first
name. A record stores information — all the data related to a particular
customer. I tell you all you need to know about fields and records in the
next chapter. 

Vertical and horizontal scroll bars are automatically displayed when-
ever all the information cannot fit on the screen just like they are on
most Windows applications.

At the bottom of the screen is a control bar used to move through the
information. This too is standard on many Windows applications. It lists
the number of the current record and the total number of records on
the form. Click the control buttons to move through the form. 

Place the cursor in each field on the form if you want to enter or mod-
ify data in the field. However, you are unable to change the form itself in
the Form view.
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Figure 1.16. Here is the Customer List for containing information about customers. 

Design view
The Design view is used to design a form by dragging and dropping
images, fields, menus, and a whole bunch of other things onto the form
that make your form useful and easy to use.

Right-click the Customer List tab and click Design view to see the
pieces of the form. 

The form is divided the following three sections:

■ Form Header. Contains objects that appear on all pages of the form.

■ Detail. Contains objects such as records that are the body of the form.

■ Form Footer. Contains objects that appear at the bottom of every
page such as a page number. (See Figure 1.17.)

The Design tab contains tools you need to insert objects onto the
form. I explain in Chapter 12 that these objects include radio buttons,
combo boxes, list boxes, check boxes, and others that give your form
intelligence. 

Records

FieldsForm view

Control bar
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20 PART I ■ GETTING STARTED

1. Click an object on the Design tab and then click on the form to add
the object to the form. 

2. Drag the object into position using grid lines as a guide for lining
up objects.

Figure 1.17. The Design view is used to place objects on a form.

Layout view
The Layout view is a combination of the Form view and Design view —
well almost. The Layout view contains information just like the Form
view, plus you can add, edit, and remove database objects as you do in the
Design view. However, the Layout view doesn’t have form sections, the
grid, and other helpful tools found in the Design view. 

Design view

Grid lines

Detail section

Fields
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1. Right-click the Customer List tab and click Layout view to display
the same form in the Layout view (see Figure 1.18). At the top of
the screen, you find two tabs. 

2. Click the Format tab to see the tools to change the font, size, and
all kinds of other things you expect to find when formatting a 
document.

3. Click the Arrange tab for tools that let you create nearly any layout
you can imagine (see Figure 1.19).

Figure 1.18. The Layout view is an intuitive tool to use to build a form.

Figure 1.19. The Form Layout Tools tab contains all the tools you need to lay out a form.

Layout view
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Working with data views
Access 2007 has its own way to display information without you having to
build a form. These are referred to as data views. Think of these as built-
in forms. These data views are the Datasheet view, the Design view,
PivotTable view, and PivotChart view. 

Let’s take a look at data views for the Northwind 2007 database.

1. Click the Supporting Objects category in the left pane to see all the
supporting objects. A supporting object is part of the database that
is not normally seen by the person who uses your database because
he uses forms instead.

2. Double-click Sales Analysis (see Figure 1.20). You’ll probably have to
scroll the vertical scroll bar to find it.

Figure 1.20. The Datasheet view displays information similar to the way information is dis-
played in a spreadsheet.

Datasheet view
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Datasheet view
The Datasheet view is one that you use a lot when developing your Access
2007 database applications. 

The Datasheet view has columns and rows similar to a spread-
sheet. You use the Datasheet view to display, add, modify, and remove
information. 

Click the cursor in a field to change the value of the field just like you
do in a spreadsheet.

Right-click the left-most column to display a pop-up menu where you
can choose options to insert a new record, delete the record, and copy
and paste the record.

Design view
The Design view is used to select the type of records that will appear in
the Datasheet view. I go over this in Chapter 6. For now, open the Design
view. 

1. Right-click the Sales Analysis tab.

2. Click Design view from the pop-up menu to display the Design view
(see Figure 1.21).

Wow! This looks very confusing, but it will be old hat to you by the
time you finish reading this book. The diagram shows boxes connected
together with lines. Each box is a table in the database. Inside the box are
names of fields of that table.

At the bottom of the screen is the query tool. A query is a request you
make to Access 2007 for information. The query tool is used to create the
request. I’ll show you how to do this in Chapter 8. 

Many times we want to see information contained in two or more
tables. In this example, we’re seeing the Order ID and Order Date from
the Orders table and the Customer Name from the Customer Extended
table. We’re also picking up information from other tables in the
Northwind 2007 database. These are listed in the Field and Table rows of
the query tool. Check marks tell Access 2007 that we want those fields to
appear in the Datasheet view.
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The lines show the fields used to link together two tables. I’ll stop here
because I think you have an idea what’s going on in the Design view. I’ll go
into the nitty-gritty of designing a Datasheet view throughout this book.

Figure 1.21. The Design view is used to select records for the Datasheet view.

PivotTable view and PivotChart view
PivotTable and PivotChart are no doubt something you don’t hear spo-
ken about every day. They are used to arrange data in a way that makes it
easy to perform data analysis interactively. 

Display field Query tool

Design view

Hack
Access 2007 is a relational database management system (DBMS). Relational
means to relate together information in two or more tables. Tables are joined
together using a value that is common to a field in both tables.
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The PivotTable view is used to arrange data and the PivotChart view is
used to create a graphic representation of the data in the PivotTable.

As information changes in the database, corresponding changes are
made to the PivotTable and PivotChart enabling you to immediately see
the impact of the change on your analysis.

You’ll learn how to create and use PivotTables and PivotCharts in
Chapter 11. 

Working with report views
A report is used to display information on a printed page or on the
screen. There are four views used with a report. These are the Report
view, Layout view, Design view, and Print view.

Take a look at report views for the Northwind 2007 database. Follow
these steps:

1. Click the Reports category in the left pane to see available reports. 

2. Double-click the Customer Address Book (see Figure 1.22). You’ll
probably have to scroll the vertical scroll bar to find it.

Figure 1.22. The Report view is used to show how data appears in print.

Report view
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Report view
The Report view shows customer names and addresses in a tabular
report. Kind of strange that all the customers live at the same address,
but remember this is only sample information.

The report has a title, column headings, and a page number (you
have to scroll down to see it). 

Notice that the names are underlined and there is an arrowhead at
the beginning of each address. Click these to see a form that contains
detailed information about the customer and address. 

Layout view and Design view
The report Layout view and the Design view are nearly the same as the form
Layout view and Design view, and they are used to create a report.

Right-click the Customer Address Book tab and select the Layout view
or Design view.

In the Design view the report is divided into sections. 
The report Design view sections the report as Report Header, Page

Header, File As Header, Detail, Page Footer, and Report Footer. 
Objects in the Report Header and Report Footer appear just once. The

Report Header appears at the beginning of the report, and the Report
Footer appears at the end of the report.

The Page Header is printed at the top of every page and the page
footer prints at the end of every page. 

File As Header is used to group information that is identified as a
group.

The Detail section appears once for each record. This is the main
body of the report.

At the top of the screen is the Design tab that contains tools for
designing the report.

Inside Scoop
Access 2007 displays a message whenever there isn’t data to display in the
Report view. Click OK if you see this message so that you can see the Report
view without the data.

Inside
Scoop
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Print Preview
Right-click the Customer Address Book tab and click Print Preview from
the pop-up menu to see how the report will look when printed by your
printer. The Print Preview tab (see Figure 1.23) at the top of the screen
provides tools to modify how the report is printed. 

These tools should be very familiar because they combine the Page
Setup, Print Preview, and Print options that you find in the File menu of
most Windows applications.

Figure 1.23. The Print Preview tab has all the tools you 
need to decide how your report is printed on paper.

Navigating the Ribbon 
The Ribbon replaces menus and contains all the tools you need to complete
any job. The contents of the tab change depending on what you’re doing. 

Some tools are grayed, indicating that they’re only available if you do
something else. For example, sorting is grayed until records are entered
into a table. This is standard operating procedure for most Windows
applications.

There are five tabs that are available when you create a blank data-
base. These are Home, Create, External Data, Database Tools, and the
Datasheet tab.

The Home tab is available all the time (see Figure 1.24) and contains
many of the tools you use all the time. 

Inside Scoop
The mouse cursor changes to a plus or minus when you move it onto the report.
The plus indicates you can enlarge the image of the report, and the minus
reduces the image of the report when you click the mouse button.

Inside
Scoop
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Figure 1.24. The Home tab appears all the time.

The Create tab (see Figure 1.25) has tools you need to create tables,
forms, reports, queries, and macros. Macro is probably one of those new
terms you rarely heard before. Think of a macro as instructions for Access
2007 to do something, such as when the user clicks a button on a form.

Figure 1.25. The Create tab is used to create tables, forms, reports, queries, and macros.

The External Data tab (see Figure 1-26) has tools to import data from
other sources such as Excel and export data so it can be used with other
applications. There are also tools to create and reply to e-mails and share
your database to a SharePoint Web site.

Figure 1.26. The External Data tab is used to import and 
export data enabling interaction with other applications.

The Database Tools tab (see Figure 1-27) is used to interact with the
database such as running a macro, show or hide, move data, or analyze
data. There are also tools to secure the database.
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Figure 1.27. The Database Tools tab is used to interact with the database.

The Datasheet tab (see Figure 1.28) has tools used to modify the
table, such as inserting new fields and adding a lookup column. You also
find tools to associate tables, which I discuss further in the next chapter.

Figure 1.28. The Datasheet tab is used to modify the table.

Just the facts
■ Place Access 2007 on the Quick Launch toolbar for a quick start

■ Create a shortcut for Access 2007 and place it on the desktop.

■ Tabs on the Ribbon replace menus and contain groups of commands
used to interact with Access 2007.

■ A gallery is a control that shows what the command can do and the
results of using the command.

■ The Quick Access toolbar is in the upper-left corner of the window
next to the Office Button.

■ There are three types of views for working with forms: Form view,
Layout view, and Design view.

■ Data views are used to display data without building a form. Data
views are: Datasheet view, Design view, PivotTable view, and
PivotChart view.

■ A report is used to display information on a printed page. There are
four views used with a report — Report view, Layout view, Design
view, and Print view.
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